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What is ThorPCX
ThorPCX is a software application that transmits, archives, and displays Thor Guard data.  If you need to acquire a copy of ThorPCX for use with your Thor Guard system, copies are made available on CD or by download:

To purchase, contact Thor Guard at:

Telephone:  888.571.1212 or 954.835.0900
Email:  sales@thorguard.com

	PC Requirements:
		
·	Windows 2000 or later
·	Windows DotNet 2.0 Framework or later
·	An available COM port (serial or USB) if the Thor Guard system is directly connected to PC.
·	A PC Network card must be configured with an IP address that can be reached in the scenario where the Thor Guard system is sending data over the Local Area Network to the PC.

Installing ThorPCX
Log into the PC with an ADMINISTRATOR account then double-click the installation file that was downloaded from http://support.thorguardweather.com or that was located on the Resource CD.  The name of the file should be named ThorPCX_Setup.msi or something very similar to this name in earlier versions.

An installation wizard will guide you through the installation process.  You will be able to change the installation path and make other setting preferences; however, it is highly recommended that you maintain the default installation settings.

IMPORTANT NOTE:
Depending upon the Windows operating system that is installed on your PC, you may receive a warning during the installation process that informs you that you must upgrade to the Windows DotNet 2.0 Framework prior to installing ThorPCX.  You must install the Windows DotNet 2.0 or later Framework prior to installing ThorPCX.  You can acquire this update from the Resource CD or by downloading it from the Thor Guard Software Download Website at:  

http://support.thorguardweather.com

Once ThorPCX has been successfully installed, you will see a shortcut to ThorPCX on your PC’s desktop.  Double-click on that icon and ThorPCX will launch and prompt you to configure the settings for the first time.

Configuring ThorPCX

Depending upon the version that you have purchased, some of the options in this documentation may not be available.  The Basic Edition of ThorPCX is the default installation.  

The first time that you double-click on the ThorPCX icon located on the Desktop, a welcome window will appear and you will be prompted to Manually Configure the program or import an existing configuration file.  

Choose the option that fits your needs and then click the Go button.

Use Existing Configuration 
If you choose Use Existing Configuration, then a window will appear that allows you to select what backup information that you want to import.

Select Import Existing Backup on the next window if you want to load all backup settings or you can select to import either the Configuration File or the Email Settings.

After choosing your option, click the Go button and then browse to and select the folder that contains the backup file.

	Manually Configure
This is the typical installation option.  Upon selecting this option and pressing the Go button, you will be presented with the ThorPCX configuration window.

The default ThorPCX Configuration.







Admin Tab

You can set an Administrator password to prevent unauthorized access to the Configuration Settings menu.  This password cannot be longer than 12 characters.

When setting an Administrator Password in conjunction with the Disable Close option on the Utilities Tab, a user is prevented from shutting down ThorPCX without first entering the Administrator Password. 
	
Backup Current Configuration
Once ThorPCX has been configured to suit your needs, then click on this button to backup all of the settings to a file.

Import Existing Configuration Items
Click on this button to import a backup file that has been previously created.

























Communications Tab

The Communications Tab contains settings that allow for you to send the data from your Thor Guard sensor to Thor Guard via the Internet.  

Report to Thor Guard
Reporting the data to Thor Guard allows for your sensor data to be integrated into a weather website that displays your sensor data along with radar, satellite, and weather conditions on an Internet-accessible website.

If you are reporting your sensor data to Thor Guard, then you must enter the 6-digit Unique ID that was issued to you.  The correct Receiver must also be selected.  Failure to properly configure this tab with the Thor Guard-assigned settings will result in the data not reaching Thor Guard.


*****IMPORTANT NOTE*****

Thor Guard data is sent out to the Internet using OUTBOUND UDP 3805 PORT.  This port must be open on each device on your network that the data will pass through on its journey to its destination.

	Send Via Proxy Server
The Thor Guard data can be sent through a proxy server if so necessary, but this is not recommended.  Enter the proper network information for the proxy server being used.

   	Forward Data to IP Addresses
This option allows the Thor Guard data to be forwarded to multiple IP addresses, public or private.  This option is useful when the PC that is connected to the Thor Guard is not the preferred destination for the data.  The data can then be forwarded to the IP address of another PC that is running ThorPCX.

This can be useful if the Thor Guard sensor is connected to a PC that has Internet access but is not on the same Local Area Network as the intended destination.  The data can be forwarded over the Internet to a public IP address on the destination network.  A PC inside the destination network can be configured to receive the data from the sending PC.   

All data is transmitted using OUTBOUND UDP 3805 PORT.
Data Tab

	The settings entered on the Data Tab determine how ThorPCX will deliver and 	display the data from your Thor Guard sensor.  

	Display Name:
Choose a descriptive name for your sensor.  This will be the name that is displayed in multiple locations.

Data Source Location:
There are three options that can be utilized to display your Thor Guard sensor data.

Local:  
If your Thor Guard sensor is connected directly to a PC via a serial or usb cable, then select this option.  You must then choose the appropriate COM port to which the Thor Guard equipment is connected.


LAN:  
Choosing this option will enable ThorPCX to “listen” for incoming Thor Guard data on an IP address that is installed in the same PC.  The IP address that is entered represents the destination endpoint where the Thor Guard data will be received.  ThorPCX must be installed on a PC that is connected to the Thor Guard equipment and it must be configured to send the Thor Guard data over the Local Area Network to the IP address (in the above step) of the PC that is running ThorPCX.  Alternatively, a network data-forwarding device could be used to forward the data from the Thor Guard unit.

NOTE:  ThorPCX listens for the incoming data on port UDP 3805.

		Remote:

NOTE:  This option allows up to 10 users to remotely view the data on any given network.  Use this option in conjunction with the Network Output File explained below.  See Appendix C for complete documentation on this feature.

Choose this option if ThorPCX will be used to remotely view the data from a Thor Guard sensor that is connected to another PC.

On the PCs that will be remotely viewing the Thor Guard data, you will need to click on the Browse button and point to the folder location on the network where the ThorPCX data file is located.

	Network Output File:
This option allows you to specify a location on your network where a data file will be continuously updated.  Click on the Generate Output File checkbox and then click the Browse button to specify the location on your internal network where you would like to create a data file and have it continuously updated with real-time data from your Thor Guard sensor.




























Logging Tab

When enabled, the Logging feature will automatically archive storm data whenever your Thor Guard sensor detects threatening weather conditions.  To enable Logging, place a check the Log Data box.  You may also choose the location where the data will be archived.  The default location is in C:\Program Files\Thor Guard\ThorPCX\DataLogs.  

You can review the storm data files by launching the Archive Viewer that is easily accessed from the main ThorPCX window.  Just click on the Data menu and then on Launch Archive Viewer.






























Utilities Tab

Several user preferences can be set on this tab to enhance the operation of ThorPCX.

	Shortcut in Start Menu
	Enabling this option will create a shortcut to ThorPCX in the Start Menu.

	Quick Launch Shortcut
Enabling this option will create a shortcut to ThorPCX in the Quick Launch Tray (contains miniature icons and is usually located at the bottom-left near the Start Menu Button).

Auto-Launch on PC Startup
Enabling this option will create a shortcut to ThorPCX in the Startup Folder.  This will cause ThorPCX to automatically launch each time the PC is started.



Auto-Launch ENS Window
Enabling this option will launch a control panel window when an Emergency Alert is launched from the Thor Guard system.  See the Emergency Alert section later in this document.

Password-Protect Emergency Alert
Enabling this option will prevent and Emergency Alert message from being issued without first entering the Administrator Password.

Play Sound on Alert
Checking this option will play an audio alert whenever the Thor Guard enters a state of Warning, Red Alert, Emergency Alert, or Tornado Alert.

Password-Protect Close
Enabling this option will prevent ThorPCX from being shutdown by prompting for the Administrator Password prior allowing a shutdown.

Show on Alert
Enabling this option will force ThorPCX to the PC Desktop each time a Red Alert or Emergency Alert occurs.

Show on Startup
Enabling this option will cause ThorPCX to be shown on the PC desktop each time it is started.




Email Alert Tab

The settings on this tab allow for the creation of a list of email addresses that will receive automatic pre-configurable text messages whenever certain Thor Guard alert levels are attained.  Click the Use Email Alerts option to enable Email Alerts.

Server Configuration
In order to deliver email/text messages, the settings must be configured to use an email server to deliver the email messages.  Typically, an email server that is located on your network would be used.  Email servers located outside your network can be used; however, it is necessary to identify and configure the necessary settings to allow relaying of email messages through those servers.

You can configure the settings for the email server that will be used to send automatic messages in the Server Configuration window.

Host Name:
Enter the valid DNS name or IP address of the email that will be used.

Port:
The SMTP port of the email server.  The default SMTP port is 25 and 465 if using a secure port.

Use SSL Security:
Choose whether the server requires the email to be Secure or Not Secure.

Sending Email Address:
Enter the email address that you want to be displayed to the recipients as the sending address.

Username:
Enter the username of a valid account that can be used to send emails to the specified email server.

Password:
Enter the password associated with the Username.










Edit Email Recipients Lists

You have the option to use a single email list where all addresses on the list will receive BOTH Weather Alerts and Emergency Alerts or you can divide the recipients into 2 lists, one for Weather Alert recipients and one for Emergency Alert recipients.

Add or Remove email addresses of those contacts that you want to receive automatic notification emails.

Most cellular phone and pager services provide documentation on how to determine the email address of your product.  This will allow you to enter the correct email address that can be used to send automatic text messages to your cellular phone or pager.

Click the Save button to save the changes or click the Cancel button to exit the window without saving changes.











Updates Tab

The Updates Tab allows for software Internet updates.

Click the Update button to retrieve the latest software updates.  When the update is in progress, you will see a progress bar on the screen.

 When the updates are downloaded, ThorPCX will apply them and then automatically restart.































Emergency Alert

If you have enabled the Auto-Launch ENS Window on the Utilities tab, the Emergency Alert window will automatically appear if an Emergency Alert is received from the connected Thor Guard hardware.  An Emergency Alert can also be launched directly from the ThorPCX software by clicking on the Alerts menu and then selecting the !Force Alert option.

Select the type of Emergency Alert Message as demonstrated below and then click the SEND ALERT button to make the message available to all network users and Remote ThorPCX viewers.  All messages can be pre-configured prior to sending an Emergency Alert; however, a Custom Message can also be created and sent.  

To cancel a software-generated Emergency Alert, click on the Alerts menu on the main ThorPCX window and then click on the Stop Emergency option.  

























Using ThorPCX

The main window of ThorPCX displays critical real-time information that is being generated by the Thor Guard system.  For a detailed description of the information displayed on this main window, view Appendix D: Thor Guard Data Reference Guide.

Settings Menu:
	Configuration
The Settings Menu contains a link to the Configuration tabs that are explained in the Configuring ThorPCX section located earlier in this manual.

Status Tile
The Status Tile is a small indicator that displays the current Thor Guard alert status.  It is useful to display this indicator if the main ThorPCX window is minimized or hidden.  Check the Show Status Tile option to display the Status Tile; uncheck to never display it.

Turn On/Off Sound
This option will turn on/off the audio alerts that are broadcast whenever the Thor Guard system indicates a Warning, Red Alert, Emergency Alert, or Tornado Alert.  This option can also be set on the Utilities tab in the Configuration settings.

Data Menu:
The Data menu allows for the viewing of Thor Guard data in real-time with View Real-Time Data option or the viewing of archived Thor Guard data with the Launch Archive Viewer option.

Launch Archive Viewer
The Archive Viewer allows for the review of Thor Guard storm data that has been previously archived.  See the Logging tab in the Configuration settings for information on setting options to log the Thor Guard data.

To utilize the Archive Viewer, click on the Launch Archive Viewer option and the Archive Viewer will be launched.



To use the Archive Viewer, click on the File menu and choose the Open option.  Browse to the archived storm file that you would like to view and then click the Open button to load the data into the Archive Viewer.  Close the Archive Viewer when you are finished reviewing the data.



	Alerts
The Alerts menu allows for the launching of a software-based Emergency Alert message.  This message will be distributed to any user who has been previously configured on the Email Recipients List.  Click on !Force Emergency to launch an alert and then on Stop Emergency to cease the alert status.  See the Email Alert Tab and the Emergency Alert sections for detailed documentation on this feature.











Contact and Support Information



Purchase the ThorPCX Software:
sales@thorguard.com
888-571-1212

Software Support Website:
http://support.thorguardweather.com

Software Support Email:
support@thorguardweather.com

Support Telephone:
786.207.8404

Appendix A

ThorPC Software Removal Procedure

The ThorPC software was retired in Spring 2008 and is currently unsupported by Thor Guard.  It has been replaced with the ThorPCX software which is fully supported by Thor Guard with ongoing updates and technical support.

Customers who currently have the ThorPC software installed on their PC(s) must correctly remove this software prior to installing the new ThorPCX software.  Follow the directions outlined below to successfully remove ThorPC in order to avoid conflicts with the new ThorPCX software.

Windows 2000 and XP
On your PC, go into the Control Panel and open the Add/Remove Programs control.  Scroll down the list until you find “ThorPC” or “ThorPcNet” or “ThorNet”.  Then click on that program to highlight it and click on the Remove or Uninstall button.  Allow Windows to completely remove the program.

IMPORTANT:  If the ThorPC program is not listed in the “Add/Remove Programs” control, then it must be manually removed.  Complete the following instructions to manually remove it.

Manually Removing ThorPC in Windows 2000 and XP
Double-click the “My Computer” icon or open Windows Explorer and navigate to the C: drive.  You will find a “THORGUARD” folder.  Delete the “THORGUARD” folder and all its contents.

You next need to delete any startup shortcuts to the ThorPC program that might exist.  You will find the startup shortcut located at the following path:

C:\Documents and Settings\Administrator\Start Menu\Programs\Startup

“Administrator” in the above example is the name of the user account.  You might have multiple user accounts listed (see examples below), so you must delete all ThorPC shortcuts from the Startup folders for ALL user accounts.

C:\Documents and Settings\John\Start Menu\Programs\Startup
C:\Documents and Settings\All Users\Start Menu\Programs\Startup
C:\Documents and Settings\Default User\Start Menu\Programs\Startup


Once the above steps have been completed, it is now possible to install the new ThorPCX software on your PC.


Windows Vista
On your PC, go into the Control Panel and open the “Programs and Features” control.  Scroll down the list until you find “ThorPC” or “ThorPcNet” or “ThorNet”.  Then click on that program to highlight it and click on the Remove or Uninstall button.  Allow Windows to completely remove the program.

IMPORTANT:  If the ThorPC program is not listed in the “Programs and Features” control, then it must be manually removed.  Complete the following instructions to manually remove it.

Manually Removing ThorPC in Windows Vista
Double-click the “My Computer” icon or open Windows Explorer and navigate to the C: drive.  You will find a “THORGUARD” folder.  Delete the “THORGUARD” folder and all its contents.

You next need to delete any startup shortcuts to the ThorPC program that might exist.  You will find the startup shortcut located at the following paths:

C:\ProgramData\Microsoft\Windows\Start Menu

OR

C:\Users\Administrator\AppData\Roaming\Microsoft\Windows\Start Menu\Programs\Startup

“Administrator” in the above example is the name of the user account.  You might have multiple user accounts listed (see examples below), so you must delete all ThorPC shortcuts from the Startup folders for ALL user accounts.

C:\Users\John\AppData\Roaming\Microsoft\Windows\Start Menu\Programs\Startup
C:\Users\All Users\AppData\Roaming\Microsoft\Windows\Start Menu\Programs\Startup
C:\Users\Default User\AppData\Roaming\Microsoft\Windows\Start Menu\Programs\Startup


Once the above steps have been completed, it is now possible to install the new ThorPCX software on your PC.

Appendix B

Configuring ThorPCX to Remotely View the Data


Software Download Site:  http://support.thorguardweather.com

Prior to completing these instructions, it is important that you have updated the ThorPCX software to the latest version.  Update the software by clicking on Settings-Configuration and then on the Updates button.  Then click the Update button to retrieve the latest update from the Internet.

Getting ThorPCX Installed and Properly Configured

1.	Install the ThorPCX software on the PC connected to the Thor Guard.  The software is located on the Resource Disk that you received or on the above website address.  A username and password is required to download the software from the above website.  Send an email to support@thorguardweather.com if you have purchased a copy of ThorPCX and need a username and password to download the software.
2.	If you are notified during the install that you need to update your version of Windows with the DotNet 2.0 Framework, you can download and install the update from the above website or the Resource CD.
3.	Launch ThorPCX from the Desktop icon and choose to Manually Configure ThorPCX when prompted. 
4.	Click on the Updates tab and press the Update button to download the latest software update from the Internet.
5.	Configure the other ThorPCX settings in order to display your Thor Guard data.  For configuration help, see the User Manual that is available from the ThorPCX Help menu, the above website address, or the Resource CD that you received.
6.	After you have configured ThorPCX, click on the Save Settings button, close ThorPCX, and then restart ThorPCX.

Making the Data available to users on the Network

1.	Once the steps in above section have been completed, you must ensure that your network users are able to reach the Thor Guard data file.  You must specify a location for the data file by clicking on Settings—Configuration and then on the Data tab.  Check the “Generate Output File” box and browse to the network folder where the file should be generated. 
2.	The folder in which the data file is being generated MUST be accessible by all remote users.  Enable Sharing on the folder in order for network users to access and view the Thor Guard data.
3.	Each network user who needs to see the Thor Guard data will need to install the ThorPCX software (refer to Step 1 in the above section).  
4.	Once ThorPCX has been successfully installed on the network user’s PC, a download of the latest software update should be performed.  Click on Settings-Configuration and then on the Updates tab and press the Update button to download the latest software update from the Internet.  Then click on the Save Settings button and restart ThorPCX.  
5.	Click on Settings--Configuration and then click on the Data tab.  Select the Remote option and click on the Browse button to locate and select the folder where the ThorPCX data file is being created as specified in Step 1.  Then click on the Save Settings button and restart ThorPCX.  If unable to see Thor Guard data, then ensure that the folder has been properly shared as indicated in Step 2.

After fully completing the steps above, you should be able to view Thor Guard data from various PCs across your network.  Please refer to the User Manual for additional information on the ThorPCX software.  




















Appendix C

DGH Configuration for Use with Thor Guard Data Transfer

Please note that your DGH data-forwarding device might have already been configured by Thor Guard.  If you did not purchase a pre-configured DGH device from Thor Guard, then follow the instructions below to configure your DGH unit.

Requirements:

Option 1--Using a serial cable for initial configuration:
·	A computer with a male RS-232 Serial Port and Hyperterminal (or similarly capable program) installed. 
·	A standard direct-connection Male to Female Serial cable (proceed to Step 2).
OR
·	A Female to Female Null-Modem cable used in conjunction with a Null-Modem adapter that is included with DGH device (proceed to Step 2).

Option 2--Using an Ethernet cable for initial configuration:
·	An Ethernet card and a crossover Ethernet cable (proceed to Step 1).

Directions:
1.  Using an ethernet crossover cable:  
a) Ensure dip switch settings are 1 and 2 to DOWN/OFF position and 3 and 4 to UP/ON position.  
b) The default IP address for the DGH is 192.168.254.254, so you will need to configure your network card to fit in this range.  Set your card to have an IP of 192.168.254.251 and a subnet mask of 255.255.255.0
c) Open a web browser and type http://192.168.254.254 and then skip to Step 6.

2.  Using a serial cable:  Flip all DGH dipswitches to the DOWN/OFF position.
a) Standard direct-connection Male to Female serial cable:  
Connect Female end to serial port on the PC and the Male end to the port on the DGH unit (DON’T use the Null Modem adapter in this scenario).
b) Female to Female Null-Modem cable 
(Must be a NULL-MODEM cable; a standard Female to Female Serial cable WILL NOT WORK):  
Connect one end to serial port on the PC and the other end to the DGH unit (be sure that Null Modem adapter IS ATTACHED to the DGH).

3.  Plug in the power to the DGH unit.

4.  Open Hyperterminal and create a connection to the COM port (usually COM 1) to which the serial cable is attached.  Use the following settings for the connection:

Bits per second:	38400
Data Bits:  		8
Parity:  		None
Stop bits:  		1
Flow control:  		None

5.  Click the connect button to establish the connection if it is not already connected.

6.  Once the menu for the DGH appears, enter the ServerConfig—Parameter menu.  Enter the proper network settings in order for the DGH to reside on your network.  DHCP is not recommended.

7.  Next enter the SerialPorts menu, click on Port 1, and then select Serial Settings.  Enter the Serial Settings documented below.



Serial Settings

Port Nr.                    	1
PortType (current)       rs232
DefaultModel              16550
MaxBaudrate               460800
Model                       	16550
Baudrate                    	9600
Manual                   	9600
FlowType                    None
DataBit                     	8
Parity                      	None
StopBit                     	1
RxFifoLength              2048
RxTriggerLevel           [1248   ]
TxFifoLength              2048
TxTriggerLevel           [1      ]

8.  Next enter the SerialPorts menu, click on Port 1, and then select Transfer Settings.  Enter the Transfer Settings documented below.  If you are sending the data to Thor Guard, then leave the destination address as shown below.  If you are sending the data to a PC on your network, then enter the IP address of that PC in the Destination field.

Transfer Settings

Port Nr.                    	1
Mode                        	UDP Mode
UDP Port(Local)      	[3805 ]
Destination               	[thornet1.thorguardweather.com ]
UDP Port(Dest)        	[3805 ]
UDP MaxPacketSize  [4096 ]
UDP Timeout             [0      ]
UDP Trigger               [                          ]

9.  Then enter the Save&Exit menu and select the Save Parameter option.

10.  Unplug the power from the DGH and then set dip switches 1 and 2 to DOWN/OFF position and 3 and 4 to UP/ON position.  

11.  You can now place physically connect the DGH device to the Thor Guard system.  Ensure that the Null Modem/Mini Adapter has been placed onto the DGH and then attach a Female to Female serial cable to the Thor Guard unit and the DGH.  Finally, use and Ethernet cable to connect the DGH to your network.

NOTE:  You can now access the DGH configuration via a web browser by typing the IP address of the DGH (if you set a static IP in Step 6) into the web browser.







Appendix D

Thor Guard Data Reference Guide


Background:  A THOR GUARD Lightning Prediction System looks at the electrostatic “charge” of the atmosphere to determine when conditions are favorable for lightning to occur.  In order to have a lightning strike in your area, there must be a “build-up” of the electrostatic field.  A THOR GUARD Lightning Prediction System has the following basic components:

1)	Energy Level:  At the top of the ThorPCX display (just below logo) will be the Energy Level indicator that displays the relative amount of positive (yellow) or negative (red) charge in the atmosphere.  Under normal conditions (no rain, storms, or high wind) the energy display will only show a small amount of charge and it is normally positive (yellow).  When storms approach or develop nearby, you will see a build-up of positive charge.  As lightning moves in closer, or when a storm is developing close to your area, you will normally see a build-up of negative energy.  Typically, when a strike occurs within the sensor range, you will see a transition from negative to positive.  The faster this reversal in charge occurs, the closer the strike.  During high winds, you will normally see a build-up of positive charge.  As the “charge” in the atmosphere increases, the Thor Guard will give you an alert level corresponding to the threat of lightning.  These levels will be displayed in the graphic display immediately below the Energy Level.
 

2)	Warning Levels:  Warning level window is located just below Energy Level 

ALL CLEAR- 	No Threat

CAUTION-	No immediate threat but situation should be monitored if storms are developing or rain is in the area.  A “Caution” level is normal with rain showers.

WARNING-	Thunderstorms and/or high wind are in the area.  Unit should be closely monitored.  Lightning is in the area or a t-storm is developing nearby or overhead.

RED ALERT-	The potential for lightning is high, all activities should stop.


3)	Emergency Alert:  User-activated feature available on ThorPCX 

NO ALERT-			No active Emergency

EMERGENCY ALERT-	Active Emergency

4)	Lightning Information Box:  Located below the Lightning Alert and Emergency Alert indication area is the Lightning Information Area that contains the following information:

LHL:  Lightning Hazard Level.  A number from 1-9.  1 means a 10% chance of lightning and 9 which means 90% chance of lightning within the Sensor Range (normally 12-15 miles).  An LHL greater than 4 indicates lightning is occurring or has the potential of occurring in your area.

DI:  Dynamic Index.  Number from 1.0 - 9.9    “1” means 10% chance and 9.9 means 99% chance of lightning within close proximity of your sensor location.  A DI > zero means there is lightning in the area!

AD:  Alarm Level.  Any time you get a Red Alert, the AD will start at 10 which means you have at least 10 minutes until you could get an All Clear signal.  The AD will reset itself to 10 until all static charge is out of the area and play can resume.  The AD will count down when no “new” surges in energy have been detected.

FCC:  Field Collapse Count.  Basically, the FCC number gives you an idea of how many lightning strikes have occurred within the sensor range.  It is helpful to watch the FCC count as the system goes from Caution-Warning-Red Alert as it allows you to see how “active” a storm is in terms of lightning strikes.


Typical readings on a THOR GUARD System during the development and/or approach of a storm are:

LHL= 6 - 9
DI= 1.6 - 4.0  (If a DI of 3 occurs, then the system will go to Red Alert)
AD= 10
FCC = 10 - 50

**The most important number is the DI!!!!  If the DI is greater than zero (typically 1.5-2.8) then you have storms within the sensor range.  If the DI starts at 1.5 and climbs to 2.5-2.8 and it looks like the storm is coming at you…chance are you will have lightning in your area within 8-20 minutes.


5)	THOR GUARD System Information Box:  Located below the Lightning Information Box, this area contains the following information regarding your THOR GUARD System

Model Type:  Indicates what model type of THOR GUARD SYSTEM you are currently operating and displaying to ThorPCX.

Format:  Identifies the data format of your THOR GUARD


Range:  Displays the range of the THOR GUARD System.  Typical ranges are 12-15 miles but may be set to lower values.  For example, when the system range is set at 12 miles, this means that the sensor is “sampling” the atmosphere out to a 12 mile radius.

Settings:  Displays the Front and Back settings of the THOR GUARD.  The factory setting is Front=2 and Back=5 and should only be adjusted by Thor Guard employees and representatives.

Test Result:  This area displays the result of the daily test automatically performed on the THOR GUARD SYSTEM.  If the system is failing the test, call Thor Guard Representative at 800-571-1212.  If there is a lot of dew and/or moisture in the air, the system may fail the morning test.  It is advisable to wait until conditions are drier to re-test.



Thor Guard Data--Quick Reference


Energy Level:	Shows fluctuations in the static field within the sensor range

All Clear and Red Alert Buttons:	Only used for systems with horns

LHL:	Lightning Hazard Level (% Chance of having a lightning strike within sensor range)

LHL Value

0 - 4
Normal Values.  “4” is common with showers and/or strong winds but should be monitored if storms are in the area
5 - 9
Lightning is in the area and DI value should be monitored closely




DI:	Dynamic Index (% Chance of having lightning near the sensor location or within 2.25 miles)

DI Value
MOST IMPORTANT VALUE TO MONITOR!!!!
0
No lightning in sensor range
1.0 - 2.0
Lightning is occurring (or will occur shortly) within sensor range) Monitor Situation!
2.0 – 2.9
Lightning is occurring (or will occur shortly) near your location (~2.5-5 miles) Monitor Situation!!
3.0 or higher
System will be in “Red Alert”.  High likelihood of lightning occurring within 2.25 miles.  Cease all activities!
Above 5.0
Lightning most likely occurring on property.  Extremely dangerous!!




AD:	Alarm Reset Time or time on minutes before “All Clear” will sound.  Always starts at 10 minutes.

FCC:	Field Collapse Count or number of lightning “discharges” in sensor range.  A good indicator of how many lightning strikes are within the sensor range.



